MTMan ei1s 2.51

Version 24.06.07

1. HOW TO GET MTMAN® WORKING?

Visit any of the following links and choose appropriate options for installing latest version of
MTMAN.

http://www.empirews2.empiretech.in

http://www.empirews.empiretech.in

a. Uninstall previous version of MTMan from your system. Remove any portable version
also.

b. Use Publish option for installation (Preferred)

c. Approve and accept any installation related prompts.

d. If any error, Download and install using Setup Installation files. Select the appropriate
version for you system. (64 Bit or 32 Bit Version)

e. Install Crystal reports 2008 (64 Bit or 32 Bit Version) for report viewing if not already
installed. (link available separately)

2. How to start working?
1. Use Ctrl+ N to get a new file in MT Level

2. Use Ctrl+ O to get a new or incomplete file in QA Level

3. You can set the working level in the menu bar. (Tools > Set Working level)

4. Use Ctrl+ D to get the Voice File to your system. (Available in My documents/MTMAN
Documents/Voice)

Tip: Set this voice file folder in your voice player software (such as express scribe) as
default location to get voice files loaded automatically.

3. Where to find current Working Voice or Document file?
Select My Menu in the Menu Bar and click on Quick Link to MTMAN Documents. Here you

will find voice file under Voice Folder and Document file under Temp Folder.
This Folder is under your My Documents Folder.

4. How to send the transcribed document to server?

MT LEVEL:
Use Alt+F6 to incomplete file, Alt+F7 to send the completed  Send | Tools Reports  Hi
file. Incomplete  Alt+F6

|
<4 Complete  Alt+F7
i)

QA/QA2 LEVEL:

Use Alt+F6 to incomplete file, Alt+F7 to complete file to send
to next QA2 level and Alt+F8 to End job

(Ready for uploading to client) the completed file.

End Job Alt+F8

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp


http://www.empirews2.empiretech.in/
http://www.empirews.empiretech.in/
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5. Request Self Logout:

MTMan ei1s 2.51

|Iser Mame

O Admin.

Lagin
s _ﬂ Request Logout

Exit

= |
L Use Alternate Server

Download MTMANE Update

Bd x| |[logh V|

6. Request Self Document Incomplete:

TTTWTEILWIINIT AU g T

Reports | Help | My Menu

& Help

Capture Screen as IPG
Use Alternate Server

L-Jj Request File Incomplete

Download MTMANE Update
Check for Updates

F'  About MTMANE

Ctrl+F& (Glohal)
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While Logging-in MTMAN, if you get a
message, ‘Already logged in another
computer’ you can use the Request
logout feature to log out yourself and
continue working.

From the login screen, type your
username and password in the
respective fields and right click in the
login screen and click Request Logout.

While Logging-in MTMAN, if you get a
message, ‘Already one file is
transcribing’, you can use the Request
File Incomplete feature to incomplete
your file automatically, and continue
working.

From the user screen, Select Help and
then click Request File Incomplete.
Make sure you have closed all your
word instances before picking the next
file.

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp



MTMan ei1s 2.51

Version 24.06.07

7. CHECKING FEEDBACK/AUDIT

1. Go to infocenter in bottom-left of the screen.

2. Select feedback center and select the feedback file.

3. Press 'download' button.. Your feedback will be downloaded in your desktop in feedback
Folder.

4. Open the feedback file and check what changes the QA has done.

5. After downloading and viewing all your feedbacks then only you will get new files!

6. Same is for Audit also if you are a QA.

8. CHECKING MESSAGES

1. Go to InfoCentre in bottom-left of the screen.

2. Select Messagecenter and select the Messages option.

3. Drag or double click the grey gridline to read the messages.

4. Double click on the message and select the text you want to copy and press Ctrl+C to
copy to the clipboard.

9. CHECKING PATIENT LIST

1. Go to InfoCentre in bottom-left of the screen.

2. Select Messagecenter and select the Patient List option.

3. The Patient Lists will be shown if it is available!

4. Select the Date of Patient List you want to download.

5. Press 'download' button.. Your Patient List will be downloaded in your MTMAN
Documents folder in MY DOCUMENTS Folder.

10. Sending Multiple Patients

a. For Normal MT Files, do

not select Voice File Patient Name* [ Bark Fle —Options

Over when sending [Last Name. First Name — Voice Over ¥
multiple Patients. Feed Back(300 Characers Max) 100 4 -
Choose Voice File Over - Infeml

only on the last patient.

Default is selected Line Count: 0

(Single Patient in the Page Count: 1

voice file.). STD Lines: 0

Cancel | Send |

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp




thﬂkalogim

b. For Pre-transcribed
documents, select New

Sending Document as © plete

[ Blank Fie
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Version 24.06.07

Patient option when s ﬁg‘éﬂp;w
sending multiple Patient [Patient No 1 m New Patient? [v
dictations in one file. Back 300 Chyfacters Max) r
Default is not selected A rf el A = .
(Single Patient in the
voice file). Line Count: 90

Page Count: 3

STD Lines: 0

Cancel ‘ Send

11. Checking for Patient history or Search for Samples

Click View = Search Documents (Ctrl + F10)

List of all documents in which the searched

MAMSZ 2214400, 10

I---Welcome KFannan I}rer ---!

word available related to the client will be Edit | View | Send Tools Reports Help My Mer
displayed. Select and view the document for 3 | » ] View Template in Use
reference. You can use the patient’s last View Encrypted Document —
name or first name to get the history of the
patient. &,  Zoom 5
Display Tool Bars Ctrl+T
Display Rulers
Display Vertical Ruler
Enable Track Revisions Ctrl+H
Show Track Revisions Alt+H
j'J' Reference Physician Search F9
Patient Information F10
7  Patient eXcel List Search  Ctrl+F9
%, Search Documents Ctrl+F10

After selecting the required patient in the
list, Click on View to Download and view the document.
selecting the next Patient in the List to view.

Click Close first and before

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp
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Search Options:

- mearcn
Word to Search

|
# PReset I : Seart:hl

[ Searchin Always On Serv

MTMan ei1s 2.51

Cuae Hmer
[Goam =] |
™ Today
f* Last 90 Days
™ Last 1year {physician)
™ Last 1year (client)

- B L S T

ord to Se
Idass'

[T Searchin Always On Server

P —

— Date Fitter
[ vam =] |
" Today
f* Last 50 Days

" Last 1year {physician)

Copy Name | View | " Last 1year (client)
- >earcn | [ vate rimer
Word to Search

X Reset | ’_t) Search |

[T Search in Always On Server

Copy Name I View I

| B 872024 ~| Up|

(¢ Last 90 Days
" Last 1year (physician)
| {7 Last 1year (client)

—
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a. Click on Always on Server when
Normal Search is down

i

Use wildcard(*) to get more
results.

c. Use Date Filter for more
appropriate Search.

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp
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12. CHECKING PATIENT NAME (Within the Software with search option
(only for EMR Clients)

I---Welcome Atul Sinha ---1

HMMTMANS 2.32.1309.18

File  Edit | Wew | Send Tools Reports  Help My Menu
ERE! _;‘_] Wiew Template in Use
Eﬁ::;neetr;trfégtl-% £0am b 5 =1 IWou can use this HelpPad as temporary 5
Woice File: i ;
EAHE?EI?S[EII:IN Display Tool Bars Chrl+T
Campaty: Display Rulers
Template:
SO Lines: Display Yertical Ruler
Client Marme:
Physician Nams Show Track Revisions Chrl-+H _I
-
1 Lj H ,_J Reference Physician Search Fa :{} q;j o - ng,l ,.I,.iﬁead! Fil
El Patient Information F10
. I T - T T T
?PatientListSearch Fil T

Select Patient List search (at present for Winthrop Ortho only)

A patient List Search

— Search First Mame | Last Name | DOB |
Last Name JOCELYM SERRAMNO 01-Mov-1996
| RODMEY TEELE 14-Apr-1962
First Mame [Patient] GRACE YERDI 11-Mav-1340
| KYLE MARTIS 17-Dec-1996
# Beszet | )_) Search | KEITH BEMT 23-May-1945
[ Search Physician Mame MAMCY BERGEMAR 25-Mov-1942
REBECCA WEINER 29-5ep-1333
ERMEST AUGHELRMNS 07-Jul-1963
r— Date Filter
- SOFIA MARGIOTTA 01 -Cck-2004
| an7ems x| |
SAMANTHA NOYOA 21-Apr-1999
& Tody AMEMRAH REID 15-Mar-1998
' This Week SAMANTHA BARMWELL 24-1uk1999
" This Manth SAMANTHA BARMWELL 24-1ul-1999
AL KEMMETH ECLIYER 18-Jul-1343
- ECHWIN AGUILA 27-Jan-2005
LCopy Here | LCopy to Patient Mame |
—— aurTaon e A4 Y 14D

Select date in the Date filter and click Update to get patient list for the particular day. You

can select week or month as per your requirement.

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp
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,..-. Patient List Search

MTMan ei1s 2.51

—Search First Name
Last Mame RODMEY
|Te PALMA
First Mame [Patient] MICOLLETTE
I FRAME
# Beset | &J Search I IRA
[” Search Physician Name DAVID
ROEBERT
MARC
— Date Filter
MOLLY
I 9/17/2013 'I Update |
EERMNARD
' Today JAKE
= Thiz Week MICHAEL
" This Month SOFLA
AL EDDDIE
- ROBERT
LCopy Here | LCopy to Patient Mame |
LUIS EMRIGUE
CHIEFFO, THERESA BONFITTOJR.. IO REBECCA
JAMES

| Last Name

TEELE
TESTAMI

DURCHHALTER.
SPATERELLA

EPSTEIN
GOLDSTEIN
EPSTEIN
FREVETE
DOSTER
WHITE
GOLDSTEIN

GORMSTEIN

FLIERTES

BLUMEMSTETTER.

COTE
TERAN
LOETTERLE
HATTER

| DpoB |

14-Apr-1962
06-1an-1937
28-1an-1993
31-]an-1930
10-Mar-1944
03-Dec-1954
27-May-1950
19-0ck-1995
0z-5ep-2010
Z26-0ck-1945
31-Jul-z011

25-Maow-2008
07-Maoy-2002
06-Dec-1950
12-Feb-1945
07-Aug-1949
23-Mar-2012
10-5ep-2001
Mok Available

DOE | MRN
17-Sep-2013 427052
17-Sep-2013 253800
17-Sep-2013 364526
17-Sep-2013 620940
17-Sep-2013 135720
17-Sep-2013 670864
17-3ep-2013 330199
17-3ep-2013 663287
17-5ep-2013 1034341
17-5ep-2013 052981
17-5ep-2013 798213
17-5ep-2013 576942
17-5ep-2013 655785
17-5ep-2013 843057
17-5ep-2013 390641
17-Sep-2013 232123
17-5ep-2013 874334
17-5ep-2013 1018888
Mot Available

| Encou...

332395
331290
329953
329272
329175
324373
FZ22899
F31867
F297AT
F27054
Fied4d
FIE2E9
301873
32R3EZ
329529
329604
330690
328893

Version 24.06.07

Type few letters in the last name field and click search to get a list of filtered patient name
list based on your search. Likewise You can type first name or the combination of first name

and last name of the patient.

,..-. Patient List Search

—Search
Last Hame
Phwzician Mame

|wass|

F Y Eesetl ;j §ealchl

¥ Search Physician Name

— Date Filter
m Update |
{* Today

' ThizWeek

' Thiz Month

ALl

LCopy to Patient Mame |

Copy Here |

First Name
MICHAEL

GARY
DAMTE
STEPHEM
PIC
RAFFAELLA

| Last Name
WOGEL

RYDER
CORADIM
MCCARTHY

BOMFITTO IR,

SORREMNTIMG

| poB
29-Apr-1990
20-Apr-1951
05-Jan-1993
24-Jun-1991
10-Apr-1995
03-Feb-1969
Mot Available

DOE
17-Sep-2
17-5ep-2
17-5ep-2
17-5ep-2
17-Sep-2
17-Sep-2
Mok Awail

You can tick Search Physician Name option and type few letters in the physician name field
to filter the list based on the provider name and click search to get a list of filtered patient
name list based on your search. Likewise you can type last name or the combination of

physician name and last name of the patient.

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp
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- Current Patient Name in Memeory : FLORES~MILTON~03091972~03132013-BLANK

Search First Name Last Hame DOB DOE MR?
Last Name KEPENS LEONARD 06-Jul-1979  13-Bep-2013 5853
FRANK ADDIEGO 27-Apr-1928  13-5ep-2013 6042
First Name PETER MURRAY 19-0ct-1958  13-5ep-2013  2555¢
TYLER BEHAR 10Nov-2001  13-5ep-2013 8335
I A  Resst I [ 4t Search ] DARIUS JONES 25-5ep-2003  13-5ep-2013  6096:
[] Search Physician Name GABRIELLA LUGINBILL 22-Jul-2003  13-Gep-2013 1003
DAMIAN STATHIS 09-Apr-2004  13-Sep-2013 1032
MILTON FLORES 09-Mar-1972  13-5ep-2013 9344
Date Filter
R —— PAMELA NICHOLAS 08-Oct-1963  13-8ep-2013 2140
13-08-2013 [E~ Update
MICHELA NARDI 02-Jun-1931  13-8ep-2013  1590:
@ Today
THOMAS CONNORS 05-Jun-1988  13-Gep-2013  4530¢
2 This Week JOHN CIARCIA 11-Jan-1960  13-5ep-2013  2420:
~) This Month SAVANMAH CASTILLO 23-Jan-2008  13-Sep-2013  5866:
O ALL GABRIELA GACCIONE 19-Mar-2001  13-8ep-2013 9777
I L : A
Copy Hore Coy 10 Paiort Name NICOLE HERNANDEZ 17-Jan-2002  13-8ep-2013 3715
PALL WIESNESKI 13May-1957 13-5ep-2013  6340:
FLORES, MILTON
DOR: 03/05/1 5.:-'21 HELEMA GARCES 14Dec-19459  13-5ep-2013 9992
RAYMOND COLON 14May-1951 13-5ep-2013 3656+

TeTonTa ATee AT T AAAA P s b

After selecting the dictated patient, click Copy Here to copy the patient hame in the text box
or click the Copy to Patient Name to copy the patient name with the DOB and DOE in the
required format to the file name in memory. It will also copy the patient nhame with DOB to the
memory. The current copied patient name is shown in the title bar. You can click reset
button to clear and reset to the old patient name.

Month . 2012

RE: LAST NAME, FIRST }'A}[EI
DOB:

RE: MARGIOTTA, S50FIA
DOB: 10/01/2004

The patient comes here for evaluation and treatment. The patient has neck pain. He

faale mimhmace and inaling dasm hie naht arm

You can also Paste the patient name and DOB in the word file later.

Patient name along with DOB and DOE copied automatically to the Patient name in send
document. Select and type appropriate type of document — CON/FUP/BLANK and send.

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp
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Problem: Line count is showing Zero when the Document (word file) is opening outside

MTMAN Editing window.
Solution:

1. Open My Computer.
2. On the Tools menu
(or the View menu),
click Folder Options (or
click Options).

3. Click the File Types
tab.

4. In the Registered
file types list, click the
specific Office document
type (for example,
Microsoft Word), and
then click Advanced (or
click Edit).

Sending Document as MT InComplete
Patient Name™ Blank File

FLORES™MILTOMN™0209197209132013-BLANK
Feed Back(50 Characters Max)

A Informal!

LastName™FirstName™D0OB™DOE

Options
Accuracy

100
U

Retum to General
Mo Standard Deduction

Line Count: 0
Page Count: 0
STD Lines: 2

Cancel | [ Send ]

5. In the Edit File Type dialog box, click to check the Browse in same window check
box (or click to check the Open Web documents in place check box).

6. OK

Or

Type the following in a notepad text file and save as a .reg (registry) file and run as admin.
(From ###<Code start> ### to ###<Code End> Lines###

###<Code start>###

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Word.Document.8]

"BrowserFlags"=dword:80000024

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Word.RTF.8]

"BrowserFlags"=dword:80000024

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Word.Document.12]

"BrowserFlags"=dword:80000024

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Word.DocumentMacroEnabled.12]

"BrowserFlags"=dword:80000024

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Excel.Sheet.8]

"BrowserFlags"=dword:80000A00

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Excel.Sheet.12]

"BrowserFlags"=dword:80000A00

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp
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[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Excel.SheetMacroEnabled.12]
"BrowserFlags"=dword:80000A00
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Excel.SheetBinaryMacroEnabled.12]
"BrowserFlags"=dword:80000A00
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\PowerPoint.Show.8]
"BrowserFlags"=dword:800000A0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\PowerPoint.Show.12]
"BrowserFlags"=dword:800000A0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\PowerPoint.ShowMacroEnabled.12]
"BrowserFlags"=dword:800000A0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\PowerPoint.SlideShow.8]
"BrowserFlags"=dword:800000A0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\PowerPoint.SlideShow.12]
"BrowserFlags"=dword:800000A0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\PowerPoint.SlideShowMacroEnabled.12]
"BrowserFlags"=dword:800000A0

###<Code End> ###

System Requirements:

Operating System:
Windows 7 SP1 or above with all security updates installed.

Office:
Office 2003/2007 (32 Bit) or above (Office XP not supported) with latest Service Packs installed

Dot net:
Dot net 2.0/3.5 or above with latest service packs installed.

For further help or queries, call +91-98 1800 8759 or buzz in whatsapp



